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User Manual for the UofL CDK20 System at Mt Kent Observatory 
 

This guide describes using the 0.5m aperture CDK20 telescope at USQ’s Mt Kent Observatory, either 

at Mt Kent or remotely, via an X Windows server. 

 

The UofL CDK20 system was supplied by the University of Louisville as part of a NASA funded 

partnership with USQ, which has become the Shared Skies project. See 

http://www.astro.louisville.edu/shared_skies/index.html .  Reference can also be made to the Mt Kent 

website at http://orion.mko.usq.edu.au/telescopes/UofL/index.html .  In particular see the Specs link. 

 

Overview - Hardware 
The dome is a 3.5m School Model from Sirius Observatories http://siriusobservatories.hopout.com.au . 

It is known as the Page dome, and is the third dome from the gate at Mt Kent Observatory, which is 30 

minutes drive south of Toowoomba, south of the village of Cambooya.  Dome rotation is monitored by 

RFID tags placed 4 degrees apart round the circumference, with the Phidgets reader accessed by USB.  

A rotation hand control with cable is hung off the rotation motor box.  The upper and lower shutters 

can be manually controlled from the shutter control box mounted chest height, or by toggling a switch, 

over the network using a WiFi link.  The upper shutter must be opened first and closed last. 

 

The telescope is a Planewave (http://planewave.com ) CDK20 0.5m aperture, f/6.8 corrected Dall-

Kirkham design with a 3.454m focal length.  This is an innovative design that provides sharp focus 

over a large field of view, and great temperature stability of focus due to its carbon-fibre truss. 

 

The primary camera is an Apogee Alta U16M http://www.ccd.com/pdf/U16M.pdf , with a 

4096x4096 sensor with 9um square pixels.  For the OTA focal length of 3.454m, this gives 0.5375 

arcsec pixels and a field of view of 36.7 arcsecs square.  This camera includes two-stage Peltier cooling 

up to -45C from ambient.  The maximum quantum efficiency is 69% at 580nm.  ADC gain is 0.67 

counts per photoelectron, with a 16 bit range.  The maximum count of 65535 is close to the full well 

equivalent count of 66666.  The dark current is equivalent to 0.133counts/sec at -25C, and the read 

noise is 6 counts at 1MHz and 2 at 5MHz (Get actual figures ????).  The camera is connected by USB 

to the dome computer - a full frame (~64Mbytes) takes ~20s to download.   

 

The focusser is a Planewave design, with a geared motor and rotary encoder.  Motion by 61um is 

required to change the focus FWHM by one pixel.  Limit switches disable excessive motion in one 

direction or the other.  The focusser is connected to a Phidgets controller in a small box on the back of 

the OTA, which also holds man-off-comp switch which should be at comp for operation. The controller 

connects to the dome computer by USB. 

 

The filterwheel is an Optec IFW-3 http://www.optecinc.com/astronomy/catalog/ifw/ifw.htm with a six 

position wheel taking 2” square filters.  The filterwheel can be easily changed without disturbing the 

optical assembly.  We have RGBL, UBVRI, griz, and narrowband filter wheels, with filters from 

Astrodon (see http://orion.mko.usq.edu.au/telescopes/UofL/instspecs.html ).  A hand controller is 

mounted on the plinth next to the telescope pier, providing home and filter select controls.  Its power 

slide switch must be on for unit operation.  The controller connects to the dome computer by a RS232 

serial cable. 

 

A finderscope is provided by a Watec 120N+ Monochrome Video Camera 

http://www.wateccameras.com/products.php?prod_id=124 with a Tamron 23FM75L 75mm f/3.9 lens.  

This gives 23”x27” pixels, for a field of view of 4.9x3.7 degrees.  The camera is connected to a video 

server at http://stv.mko.usq.edu.au/ (Login as root with password #3).  A hand controller with frame-

rate and gain controls is velcroed to the side of the mount.  In a browser window, the camera is oriented  

 The same as ds9 & xephem (left=E up=N) when the telescope is pointing W 

 rotated 180 deg when the telescope is pointing E (can rotate in Video Server->Setup-

>Video&Image->RotateImage) 

 

Ultra-wide angle imaging is provided by a Nikon D200 camera equipped with a Nikon AF Nikkor 

75mm f/1.4 lens.  This provides a field of view of 15.5 x 10.5 degrees, with 10.2M pixels (3872x2592).  

http://www.astro.louisville.edu/shared_skies/index.html
http://orion.mko.usq.edu.au/telescopes/UofL/index.html
http://siriusobservatories.hopout.com.au/
http://planewave.com/
http://www.ccd.com/pdf/U16M.pdf
http://www.optecinc.com/astronomy/catalog/ifw/ifw.htm
http://orion.mko.usq.edu.au/telescopes/UofL/instspecs.html
http://www.wateccameras.com/products.php?prod_id=124
http://stv.mko.usq.edu.au/
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The mount is a Planewave Ascension 200HR http://planewave.com/products-page/mounts/ascension-

200hr/ equipped with high resolution encoders directly mounted on the RA and Dec axes (additional to 

rotary encoders on the geared drive motors).  The mount can handle up 125kg load.  A hand control is 

velcroed to the side of the pier (this can be used without disturbing xmtel – may have to nudge the 

mount from xmtel to get it to update indicators).  This is a German Equatorial Mount, and crossing the 

local meridian (eg from east to west) requires the two axes to be moved through 180 degrees and the 

telescope resynced. 

 

The dome computer is at crux.mko.usq.edu, and is directly connected by USB to the primary camera, 

focusser, ultra-wide imager and RFID reader.  The filterwheel has a serial connection.  Other devices 

are controlled over the network.  A monitor and mouse and keyboard provide console access to crux.  

The computer can be moved forward in its rack for better access to its rear.  Log in as observer and use 

password #1. 

 

A dome camera, an Axis 214 PTZ ethernet camera at http://domecam.mko.usq.edu.au , provides high 

quality video with pan, tilt, zoom, focus and gain settings.  The user is root and password is #3.  The 

camera is mounted on the west side of the dome and looks east, so that north is to the left and the 

distant dome wall is the east wall. 

 

A dome light can be controlled remotely to support use of the dome camera, and is toggled from  

http://pagepower.mko.usq.edu.au. 

 

Temperature and humidity for the OTA are measured by sensors connected to the focus motor 

controller.  

 

Power control is by a DigitalLoggers Ethernet Power Controller at http://pagepower.mko.usq.edu.au 

with username admin and password #3.  This allows separate control of the following: 

1. Dome 

2. Dome Camera, Video Server 

3. Mount 

4. Primary Camera 

5. Filter wheel 

6. Focusser, finderscope 

7. Dome light 

These can also be operated by the hardware switches on the unit in the rack.  Remember to leave the 

switches in the middle position to allow remote operation. 

 

A dome fan is temperature controlled and brings in external filtered air near ground level, to be 

exhausted at the top of the dome, attempting to reduce summer temperatures inside the dome. 

 

Dome flats if needed can be provided by a light box illuminating a white surface on the inside of the 

lower shutter. 

 

Overview - Software 
The operating system on crux, the dome computer, is the OpenSuse version of Linux.  It is accessed 

from eg canopus in the EDG building or from a Linux system within USQ’s firewall by 

ssh –Y crux.mko.usq.edu.au 

From outside the USQ firewall, the user will need to make a VPN connection to the USQ Linux 

machine stardust first. 

 

Some programs are run instead on the mtkent1 server at the observatory.   

 

The control/analysis software for the system is open-source, and mainly developed by Dr Kielkopf and 

Karen Collins from University of Louisville.  Most code is in C or Java; scripting is being ported 

mostly to python. 

 

Most programs are in   /usr/local/bin 

Preferences are in   /usr/local/observatory/prefs 

Various status files are in  /usr/local/observatory/status 

Data on crux is in (while observing) /home/observer/data/tonight 

http://planewave.com/products-page/mounts/ascension-200hr/
http://planewave.com/products-page/mounts/ascension-200hr/
http://domecam.mko.usq.edu.au/
http://pagepower.mko.usq.edu.au/
http://pagepower.mko.usq.edu.au/
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 (otherwise)   /home/observer/data/YYMMDD 

where the date is of the night of observation. 

A copy is stored on mtkent1 at /data1/cdk20s/YYMMDD 

and is backed up on mtkent2 at Mt Kent Observatory and mtkent3 and mtkent4 at University of 

Louisville’s Moore Observatory. 

 

Main Programs 
 

xephem  Written by Elwood Downey, this program provides a zoomable sky view, an 

extensive object database, markers for telescope and target position, and much more. See 

http://www.clearskyinstitute.com/xephem/help/xephem.html for the reference manual. 

xmtel  Provides a GUI for controlling the telescope. 

xmccd  Provides a GUI for controlling the primary camera. 

ds9  From the Smithsonian Astrophysical Observatory (SAO), this GUI provides viewing 

and some analysis of fits image files produced by xmccd. 

domeshow.sh Shows the current dome azimuth. 

dometrack.py Moves the dome to match the current telescope azimuth. 

getfocus  Gets the current focus position in encoder counts. 

setfocus  Changes the focus position by a number of pixels 

plotfocus.py Plots the FWHM, amplitude, and focus value for a selected star in a series of ds9 

images, to aid in focussing 

solve-field-cdk20 Run on mtkent1, this script performs astrometry on an image using the 

astrometry.net code (http://astrometry.net/).  It reports back the J2000 coordinates of the centre of the 

image, and generates an image with WCS coordinates included (as filename.new). 

solve-field-fast-cdk20 Is faster if the auxilliary images are not wanted. 

imdark etc A suite of programs to perform elementary operations on fits image files, ie dark 

subtraction (ls /usr/local/bin/im*) 

astrocc  Nominally a coordinate converter, but can also search for targets, provide times and 

airmass. 

astroimagej A powerful GUI run on mtkent1 for performing relative aperture photometry on 

images.  It is based on ImageJ (http://rsbweb.nih.gov/ij ) and Göttingen ImageJ Resources 

(http://www.astro.physik.uni-goettingen.de/~hessman/ImageJ/ ).   

See http://www.astro.louisville.edu/software/astroimagej/ .   

AstroImageJ can provide live plotting of the results of photometry on a series of images. 

gphoto2, eog Nikon image fetch and view. 

session_start.sh  

observatory_start.sh 

session_stop.sh  

observatory_stop.sh 

These scripts are the preferred way of starting and stopping an observing session, and handle powering 

up the hardware and opening the shutters, setting up data directories, running background processes, 

and starting up the various GUIs for controlling the hardware. 

look_east.sh, look_west.sh These are used to choose the appropriate scripts for scripted 

tracking (discussed later), which depends on whether the telescope is pointed east or west of the local 

meridian. 

temphumid_get.py  Read the telescope temperature and humidity. 

 

Support Programs 
These are infrequently used programs/scripts, or are run in the background. 

indiserver This server program is run in the background, and communicates directly with the 

mount and primary camera via drivers.  xephem, xmtel, xmccd then talk to indiserver to control the 

hardware.  The hardware settings can be seen or changed from the indipanel GUI, which can be opened 

by a menu item from xephem’s skyview window. 

indiget, indiset These command line programs can be used to access the hardware settings in 

indiserver, and are useful in scripting. 

dome_monitor.py This program runs in the background and reads the dome RFID tags as they 

pass, writing the current tag value to a file. 

dome_azimuth_change.py Moves the dome 

shutter_open, shutter_close Controls the shutters ????? 

http://www.clearskyinstitute.com/xephem/help/xephem.html
http://astrometry.net/
http://rsbweb.nih.gov/ij
http://www.astro.physik.uni-goettingen.de/~hessman/ImageJ/
http://www.astro.louisville.edu/software/astroimagej/
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update_tonight.sh Sets up the cron system process to check every two minutes for any file 

changes in the crux directory /home/observer/data/tonight, and update the corresponding directory 

/data1/cdk20s/data/tonight. 

ccd_monitor.sh 

ccd_process.py 
guide.py These scripts facilitate keeping a selected star on the same ds9 pixels over hours, and 

also keep the dome aligned with the telescope. 

 

Starting an observing session 
Now (and frequently thereafter) is a good time to check the weather.  See the “Checking the weather” 

section.  There is weather checking software in place/being developed, but it is also important to do 

your own monitoring.  Please don’t open up when the weather is dubious (it is easy to get absorbed in 

observing etc and miss that damaging shower) or when the humidity is above 95% (and be checking 

regularly for condensation when above 90%).  Also it is generally inadvisable to open the shutters 

between sunrise and sunset unless certain that direct sunlight cannot reach the telescope mirrors. 

 

If not already released, the two dome lockdown fasteners must be released, and the two lockdown 

catches between the upper and lower shutter also released.  The covers over the telescope apertures 

must be removed.  It is also a good idea to check that chairs etc are clear of the telescope space against 

the dome wall. 

 

The telescope must be in the “top-dead-centre” position before the mount is powered, that is, pointing 

to the south celestial pole with the telescope “above” the mount.  If necessary, power up the mount and 

use the hand controller, or do the following: 

1. In one window run “indiserver tel” 

2. In another window run xmtel, and select the slew checkbox (not the button) 

3. Using the dome camera zoomed in, align the marks (on white background) using the NSEW 

buttons in xmtel 

4. Remember to power the mount off (so that its encoders are reset on startup). 

 

Change the filterwheel name (read by xmccd on startup).  The filterwheel names are in *.ccd files in 

/usr/local/observatory/prefs.  Copy the appropriate file to prefs.ccd in the same directory. 

 

Now run session_start.sh, and wait for it to finish.  This will power up all except the dome and dome 

light, start xephem, xmtel, xmccd and ds9 as well as background programs, and set up the tonight data 

directories on crux and mtkent1. 

 

Next run observatory_start.sh, and wait for it to finish.  This will power the dome and the dome light, 

and open the shutters (you did check the weather, right?) 

 

There are a couple of operations that the scripts cannot perform.   

1. From the top of the small xephem GUI pull down the View menu and select SkyView.  This 

will open a sky view window.  

2. From the top of this new window, pull down the Telescope menu and select INDI panel.  This 

will open an Indiserver panel window. 

3. At the bottom of this new window, click on the Connect button.  This will show icons for tel 

and ccd which can be expanded (click on +) to see the various parameters.  In the panel above 

will appear messages about changes to the mount and camera. 

4. The camera temperature has been preset to -10C.  If a different value is desired, this can be 

changed from the xmccd Set menu 

 

Note that it takes time for the camera temperature to stabilize (~30m) and for the dome and telescope to 

equilibrate (up to an hour). 

 

It doesn’t hurt to open a log.txt file in the tonight directory on crux (/home/observer/data/tonight), to 

record details of the night’s observations.  A simple text editor on crux is nedit. 

 

Lastly, move the telescope from pointing to the south celestial pole to the desired side (east or west).  

Check movement in the dome camera at http://domecam.mko.usq.edu.au .  Ensure that the slew 

checkbox near the top of xmtel is selected.  If intending to look east for example, use the xmtel W 

http://domecam.mko.usq.edu.au/
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button to move the telescope body ~20 degrees.  The telescope (not the weights) should move towards 

you in the camera.  Then use the N button to move the telescope northwards.  In the camera this should 

show the telescope pointing higher in the sky. In xephem’s skyview window, the telescope marker 

should move from the south celestial pole northwards in the eastern (left) side of the sky. 

 

Routine procedures 

 

Checking the weather 
The number one responsibility after operating the telescope is to ensure both shutters are properly 

closed.   

 

The number two responsibility is to check the weather before opening up and regularly during an 

observing run.  An automatic closing system is being installed, but it is best to regard this as a backup. 

 

The weather instruments can be accessed at:  http://orion.mko.usq.edu.au/cgi-bin/Davis2Html.cgi .  Of 

particular interest is the Boltwood Cloud Detector, which has a field of view of ~90 degrees and looks 

a bit west of the zenith.  Readings more positive that ~-30C indicate some cloud present, and caution 

should be exercised.  The Boltwood will also detect the presence of rain, responding faster than the 

Davis weather station. 

 

A backup cloud detector and rain detectors have been installed and will be available soon.  How to 

access ??? 

 

An all sky camera is available at http://skycam.mko.usq.edu.au (username root with password #3) as a 

further check on cloud.  To save heavy bandwidth usage, get a snapshot by going to 

http://moondog.astro.louisville.edu/remote/video/index.html  

and pressing the Southern Night Sky button. 

 

Syncing the mount 
This procedure provides a way of ensuring very accurate pointing (target typically ends up dead centre 

in the image on first go), using the astrometry.net software.  It currently must be repeated after moving 

from the east to west part of the sky or vice versa. 

 

1. Slew the telescope with xmtel (with the NSEW buttons, or enter coordinates in the target 

boxes then click the slew button) to the target or a suitable mid-altitude point.  (Don’t go 

within 10 degrees of the pole or the local meridian.) 

2. Set the Basename as test in the xmccd Fits menu, the exposure time to 10s from the Set  menu,  

and a midrange filter from the Filter menu.   

3. Take an exposure with the Expose button.  (Download will take ~20s) 

4. Astrometry works best with a dark-subtracted and focussed image.  If the image isn’t sharp, 

focus as described later. 

5. Select Dark from xmccd’s Type dropdown menu.  Then take a dark frame with the Expose 

button. (Remember to change Type back to Light) 

6. Change directory on crux to /home/observer/data/tonight. 

7. Make a dark-subtracted image with the command line “imdark testnnnnn.fits 

dark_mmmmm.fits  testnnnnnd.fits”  where nnnnn etc refers to the appropriate image serial 

numbers. 

8. Now move the dark-subtracted image testnnnnnd.fits to mtkent1 with the command line “scp 

testnnnnnd.fits  mtkent1:/home/observer/data/junk” 

9. Log in as observer on mtkent1, and change directory to /home/observer/data/junk 

10. Run the command “solve-field-fast-cdk20  testnnnnnd.fits and wait for the coordinates of the 

centre of the solved field to be given.  (If this takes more than a couple of minutes, Ctl-c to 

exit, point the telescope elsewhere, and repeat).  These coordinates are for epoch J2000. 

11. Now convert these J2000 coordinates to Equinox of Date (EOD) coordinates.  On the xephem 

root GUI, pulldown the Tools menu and select Coordinates Converter.  In the top left box 

enter EOD.  In the second line, paste the RA and Dec produced from the astrometry (J2000 

coordinates).  The converter will then produce the equivalent EOD coordinates in the first 

line.  Paste these into the Target boxes of xmtel. 

http://orion.mko.usq.edu.au/cgi-bin/Davis2Html.cgi
http://skycam.mko.usq.edu.au/
http://moondog.astro.louisville.edu/remote/video/index.html


 6 

12. Finally, to sync the mount, in xmtel pulldown the Reference menu and select Target, then 

pulldown the Pointing menu and select Offset.  If the Guide checkbox at the top left of xmtel 

is selected, and the mount is nudged with one click on one of the NSEW buttons, the Telescope 

boxes should be seen to match the Target boxes.  The software has offset its internal RA and 

Dec variables to match where the telescope is pointing as determined by astrometry. 

 

Crossing the local meridian (E->W or W->E) 
The telescope should not be slewed across the local meridian (line from N to S passing directly 

overhead).  Instead follow this procedure. 

1. In xmtel, turn off the pointing correction by pullingdown the Pointing menu and deselecting 

Offset. 

2. Move the telescope to dec ~-85S (either by the S button, or by entering -85 in the Target Dec 

box then clicking the Slew button. 

3. Turn the dome light on, and use the dome camera to view the telescope. 

4. With the Slew checkbox for speed selected, press and hold the Slew button, until the telescope 

has moved well past the dec = -90 position.  (This can be seen in the camera on the white tape 

markers on the dec axis).   

5. The RA can now be slewed through the top-dead-centre position ie moving the telescope 

across the local meridian.  If the telescope is to now point east, use the E button (the telescope 

should move towards the dome camera).  If the telescope is to now point west, use the W 

button (the telescope should move away from the dome camera). 

6. Check in xephem’s SkyView window that the telescope marker is on the desired side of the 

meridian. 

7. Remember to adjust ds9’s image rotate/flip for the different side of the meridian, as follows. 

For the telescope:  

 pointing E, pull down the Zoom menu and select InvertY.  (All other transforms off) 

 pointing W, pull down the Zoom menu and select InvertX.  (All other transforms off) 

 

Slewing to a target 
Slewing to a target can be as simple as entering Equinox of Date (EOD or Now) coordinates into 

xmtel’s Target boxes and pressing the Slew button.  Once the target is reached, the mount starts 

tracking with the motor encoders only (good for a few tens of seconds exposure).  A “Goto complete” 

will briefly appear in the xmtel message window. (Alternatively the message can be seen in the 

message section of the Indipanel window).  If the telescope has been synced and EOD coordinates were 

entered, the target should appear in the centre of the field. 

 

To convert J2000 coordinates to EOD, see #11 of “Syncing the Mount”.  Alternatively start up astrocc 

(EOD coordinates are produced in the bottom section.) 

 

For longer exposures (typically 20-100s, perhaps to 300s), the high-res encoders should be used, by 

clicking the xmtel Guiding button.  To keep the target on the same pixels over longer periods (to many 

hours), see the “Scripted Guiding” section. 

 

To stop the mount click xmtel’s Stop button.  This also stops tracking and guiding. 

 

Note that xmtel will not slew within ~10 degrees of the horizon, or far across the local meridian (see 

“Crossing the local meridian”). 

 

Note too that xephem does not automatically update the time it is using – press the Update button for 

this. (If forgotten, RA and Dec are of course unaffected but Azimuth and Altitude are.) 

 

The Target boxes of xmtel can also be filled by right-clicking on an object in xephem’s SkyView 

window, and selecting Telescope GoTo (doesn’t work for planets).  Alternatively, a target can be 

searched for by name using xephem’s Data menu.  From this select Index, and a search window opens.  

Make sure the All checkbox is checked.  The search box is fussy (“M31” not “m 31” but “NGC 5866”; 

it also helps to put a * wildcard on the end).  At the bottom of the window, the SkyPoint button will 

mark the target in the SkyView window and the Telescope GoTo button will load the coordinates into 

xmtel’s Target boxes. 
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If a desired target is not found, other catalogs can be included by pulling down the Data menu then 

selecting Files.  In the resulting new window select again the Files menu and select from the offered 

catalogs (described in following table, together with number of objects). 

 

General clusters, nebulae, galaxies 

 NGC.edb 7,955  Revised New General Catalog 

(2005) 

 

 IC.edb 5,201 Revised Index Catalog (2005 

-NGC supplement) 

 

 Messier.edb 110 Messier Objects Catalog 

(2005) 

 

 SAC.edb 1,887 Saguaro Astro Club (2002)  

 ovocc.edb 1,599 Optically Visible Open 

Clusters Catalog (2002) 

Our galaxy 

 DeepSky-C.edb 326 Deep Sky Objects Common 

Names (2003) 

 

 pleiades.edb 442 Pleiades field membership 

(1995) 

 

Galaxies etc 

 HYPERLEDA.edb 101,767 HYPERLEDA Catalog (2003 

Part 1 – Bright) 

Bright 

 HYPERLEDA_dim.edb 881,495 HYPERLEDA Catalog (2003 

Part 2 - Dim) 

Brighter than 

18B mag 

 UGC.edb 7,331 Uppsala General Catalog Bright Galaxies 

(from Palomar 

Sky Survey) 

 cgcg.edb 29,363 Galaxies and Clusters of 

Galaxies Catalog (Zwicky) 

Galaxies & 

clusters of 

galaxies 

 Abell.edb 5,250 Catalog of Rich Clusters of 

Galaxies (1989) 

Clusters of 

galaxies 

 Hickson.edb 563 Hickson Objects Catalog 

(1994) 

Compact clusters 

of galaxies 

 qagn.edb 64,866 Quasars & Active Galactic 

Nucleii 

 (2003) 

 

Nebulae etc 

 lbn.edb 1,125 Lynd's Bright Nebulae (1965) Dec N to ~30S 

 ldn.edb 1,791 Lynd's Dark Nebulae (1962) Dec N to ~30S 

 Barnard.edb 349 Barnard's Catalog of Dark 

Objects (1927) 

Milky Way 

 DCld.edb  1,101 Catalog of Dark Southern 

Clouds (1986) 

South of 33S 

 cgsr.edb 231 Catalog of Galactic 

Supernova Remnants (2001) 

 

 sh2.edb 314 Sharpless HII Regions (1959) Dec N to 27S 

 hh.edb 454 Herbig-Haro Objects Star formation 

Stars 

 Hiptyc2.xe2 2,538,127 Hipparcos & Tycho-2 

Catalogs 

 

 bs.edb 5,953 Bright Star Catalog  

 YBS.edb  Yale Bright Stars Catalog  

 Starsnav.edb 173 Nautical Almanac Navigation  

 SKY2k65.edb 8,882 SKY2000 (Bright subset) Above M6.5 

 SKY2000 299,167 SKY2000 Master Catalog 

(2002) 

Above M8 

 hd.edb 272,150 Henry Draper Catalog and 

Extension (1924) 

~complete to M9 

 hde.edb 88,883 Henry Draper Extension 

Charts, (1995) 

Fainter 

magnitudes 
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 Pulkovo.edb 

 

58,483 Pulkovo Pul-3 Catalog Astrometric, 

proper motions 

 XZ80Q.edb 244,269 XZ Catalog of Zodiacal Stars 

(2003) 

 

 ppm.xe2 468586 468,586 Positions and Proper Motions 

Catalog 

 

Stars: doubles, variables, etc 

 gcvs.edb 31,852 General Catalog of Variable 

Stars 

 

 aavso.edb 28,435 AAVSO Stars Catalog Variables 

 WDSC.edb 98,186 Washington Visual Double 

Star Catalog (2005) 

 

 CCDM.edb 105,838 CCDM-Components of 

Double and Multiple Stars  

 

 COVBS.edb 1,832 Sixth Catalog of Orbits of 

Visual Binary Stars  

Orbits of Visual 

Binaries 

 SSC.edb 2,872 Sternberg Supernova 

Catalogue (2004) 

 

 pulsars.edb 559 Princeton Pulsars Catalog 

(1993) 

 

Calibration/Photometry 

 loneos.edb 33,860 LONEOS Photometry 

Catalog (2003) 

 

 CPIRSS.edb 37,700 USNO IR Stellar Sources 

Catalog CPIRSS (1984) 

 

 Zwicky.edb 19,368 The Updated Zwicky Catalog 

(1999) 

Galaxies 

 sstar_calib.edb 1,179 WDS Single Star Calibration 

Catalog (2004) 

 

 constant.edb 34 Catalog of Constant 

Brightness Stars (1997) 

Constant 

Brightness Stars 

 vla*cm.edb 2,531 VLA Radio Calibrator 

Sources  

 

 binary_calib.edb 81 WDS Binary Star Calibration 

List (2004)  

 

Note: The Guide Star Catalog (GSC) is built into xephem in a special compressed form which cannot 

be searched, but its stars are displayed. (They are called Field Stars.  GSC2201 has 451,632,833 stars 

up to M18.5 and gsc has 18, 839,509 stars up to M15). 

 

Alternatively Simbad (http://simbad.u-strasbg.fr/simbad/sim-fid ) is a great way to search for an object 

by name and retrieve its coordinates. 

 

Another great way to search xephem’s catalogs, with very flexible search criteria, sorting capability 

and outputs selection, is at http://orion.mko.usq.edu.au/cgi-bin/objects.cgi .  If you have a USQ login, 

we can allow you to also output the actual catalog data lines at https://orion.mko.usq.edu.au/cgi-

bin/objectsfull.cgi .  Help for these is available at the websites.  For example, you can search for all 

objects in a selection of catalogs that will be within 5 degrees of a specified RA * Dec at 9pm 

tomorrow night. 

 

Confirming “on target” 
Ensure that rotate/flip in ds9 are set correctly for which side of the local meridian the image was taken 

(this ensures the image is displayed E-left N-up).   

For the telescope:  

 pointing E, pull down the Zoom menu and select InvertY.  (All other transforms off) 

 pointing W, pull down the Zoom menu and select InvertX.  (All other transforms off) 

 

Bring up an xephem SkyView image that matches the image taken with the primary camera: 

1. Ensure SkyView is in equatorial (RA-Dec) mode (Axes button half way down the left toggles 

between this and Alt-Az) with E-left N-up (indicator at bottom right – otherwise use flip 

buttons on left).   

http://simbad.u-strasbg.fr/simbad/sim-fid
http://orion.mko.usq.edu.au/cgi-bin/objects.cgi
https://orion.mko.usq.edu.au/cgi-bin/objectsfull.cgi
https://orion.mko.usq.edu.au/cgi-bin/objectsfull.cgi
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2. Pull down SkyView’s top left Control menu and select Eyepieces to bring up the eyepieces 

window.  Click on the Use button to the left of the Apogee box to select a field of view 

matching the CDK20-Apogee camera field of view (FOV). Then close the eyepiece window. 

3. Right click on the target and select Center to center the target, then drag the left slider near to 

the top to zoom nearly fully in.   

4. Again right click on the target and select Place Eyepiece.  A square box matching the camera 

FOV will appear centred on the target. 

 

Now compare star distances, pair angles and brightness (allowing for different filters) to confirm the 

target position.  Skyview star brightness can be adjusted with the “light bulb” buttons at the upper left. 

 

Alternatively Aladin http://aladin.u-strasbg.fr/java/alapre.pl can be used to retrieve a real image for 

comparison. 

 

For completely unambiguous target identification by its coordinates, astrometry can be used as in 

“Syncing the mount” but using “solve-field-cdk20 filename.fits”.  This will produce an image named 

filename.out which has coordinates embedded.  This image can then be displayed in ds9 on mtkent1, 

and moving the mouse over the image will display J2000 epoch coordinates for the mouse position.  

An annotated image can also be produced. 

 

Moving the dome 
To move the dome to align with the telescope, give the command “dome_track.py”.  The command 

“dome_show.py” will show where the dome currently is.  (Both commands rely on dome_monitor.py 

running in the background.  This is started by the startup scripts).  The dome will track to within 5 

degrees.  Note that dome_track.py runs once – it does not keep the dome tracking as the telescope is 

moved. 

 

The command “dome_azimuth_change   angle” will change the current dome azimuth by the signed 

angle in degrees. 

 

Taking an image 
From the xmccd GUI do the following if not already done: 

1. Pull down the Set menu and set 

a. The exposure time in seconds 

b. The number of images to take if doing a multi-image exposure (Multiframe count) 

c. The sequence number to include in the filename,only if it needs changing (Image 

number) 

d. Image region if a download of the full image is not required. 

2. Pull down the Fits menu and set 

a. The Basename for the filename (remember to include an underscore after trailing 

numbers to distinguish the sequence number appended by xmccd).  Xmccd 

automatically sets names for dark, bias and flat fields when these types of images are 

selected. 

b. The name of the target (added to the fits header) 

3. Pull down the Filter menu and select the filter (Names are filled in once the filter is selected).  

See “Starting an observing session” for changing the filterwheel ID.  Currently this must be 

done before xmccd is started.  The filter sets are: 
UBVRI     RGB                  GRIZ                     Narrow 

1 U       1 Clear (UV Block)   1 g'                     1 SII 

2 B       2 R                  2 r'                     2 Ha 

3 V       3 G                  3 i'                     3 Red Continuum 

4 R       4 B                  4 z'                     4 OIII 

5 I       5 Open               5 BlueBlock (Exoplanet)  5 Clear (UV Block) 

6 Open    6 Open               6 Open                   6 Open 

 

4. Pull down the Mode menu and select either Single frame or Multi frames. 

5. Pull down the Type menu and select one of Light, Dark, Bias, Flat. 

6. Pull down the Processing menu and 

a. Tick Transfer if the image once downloaded is to be opened in ds9 automatically. 

b. Tick Scripting if scripted tracking is desired. (See the “Scripted tracking” section.) 

 

http://aladin.u-strasbg.fr/java/alapre.pl
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If the exposure is longer than ~10s, guiding with the high-res encoders is probably required.  Press 

xmtel’s Guiding button (it toggles guiding) if not already pressed and check the state in xmtel’s 

message pane or in xephem’s IndiPanel. 

 

Now press xmccd’s Expose button, and the Exposure indicator will count down the exposure seconds.  

It then takes about 20s for the image to download.  When this is complete, the Status indicator will 

change to Camera ready and the Filename indicator will show the new filename.  If automatic transfer 

is enabled (see 6a above) the new image will then be displayed in ds9. 

 

An exposure can be interrupted with xmccd’s Interrupt button 

 

Viewing an image 
Sao ds9 is a powerful astronomical image viewer.  For user and reference manuals, a FAQ, and 

tutorials see http://hea-www.harvard.edu/RD/ds9/site/Documentation.html .  The following are some 

useful introductory operations. 

 

Note that the Magnifier (top right box) is a magnified subsection of the displayed part of the image, 

about the current mouse position, with the central cursor showing the mouse position and the size of 

one pixel.  The Panner to the left represents the total image, with the box indicating what is shown in 

the main image window.  The box in the Panner can be dragged to pan across the image. 

 

From the View pulldown menu it is useful to tick Horizontal Graph and Vertical Graph in order to see 

cross-sections through objects as the mouse is moved.  The Min Max and Low High options are also 

useful for seeing pixel extreme values. 

 

The Scale button or menu gives choices for how brightness and contrast are transformed from the fits 

file data to the display.  Linear is useful for seeing the image with just a linear transform.  Log is useful 

for bringing out fainter detail of eg nebulae and galaxies and faint stars.  In both cases, right clicking 

and dragging across the image in one direction changes brightness and in the other contrast.  For more 

control, from the Scale pulldown menu select Scale Parameters, which opens a histogram window 

where the black and white levels in pixel counts can be set. 

 

The Zoom button or menu allows zooming in/out. 

 

To orient the image with the usual convention left-E up-N, it must be flipped depending on whether 

the telescope was looking east or west (characteristic of German Equatorial Mounts). 

For the telescope: 

 pointing E, pull down the Zoom menu and select InvertY.  (All other transforms off) 

 pointing W, pull down the Zoom menu and select InvertX.  (All other transforms off) 

With this convention, 

 as the xmtel E button moves the telescope E, the star appears to move W in ds9. 

 as the xmtel N button moves the telescope N, the star appears to move S in ds9. 

In summary, with these settings, east is to the left and north is up, and the xmtel NSEW buttons move 

the telescope in the indicated directions (star in display moves in opposite direction). 

 

A Pixel Table showing pixel values in a small region about the cursor can be generated by selecting 

Pixel Table under the Analysis menu.  Size can be adjusted from its Size menu. 

 

The Fits Header can be displayed by pulling down the File menu and selecting Display Fits Header. 

 

The Color menu allows selecting the colormap and for example selecting black stars on a white 

background with the Invert Colormap option.  The Reset Colormap sets contrast/bias to the default 

values. 

 

By selecting Preserve During Load from the File menu, one can select individually whether the 

following are preserved during load of a new file 

 Existing scale parameters 

 Existing pan location 

 Existing regions 

 

http://hea-www.harvard.edu/RD/ds9/site/Documentation.html
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The Regions menu allows drawing various shapes (circles, rectangles, lines, text etc) on the displayed 

image.  These can be for annotation, or various forms of processing (eg for scripted tracking).  If 

regions are not being used, they can be deleted with the Delete All Regions, and showing regions can 

be disabled by deselecting Show in the Region Parameters selection.  Regions are drawn by click-and 

drag on the image, and selected by clicking within the region.  A selected region can be dragged, or 

resized by dragging over the handles.  The Get Region selection on the Regions menu brings up a 

dialog box that allows read/write of the parameters of a selected region. 

 

To find a star’s centroid: 

1. Region=>Region Parameters=>Centroid Parameters    Set Radius to max (50) 

2. Put a region round a star and leave it selected 

3. On command line, do “xpaset -p ds9 regions centroid”.  This moves the region to the star's 

centroid. 

4. Run “xpaget ds9 regions”. This gets the region's properties, including the circle’s (X,Y,R) 

 

This can also be done from within ds9.  Once the region is drawn and selected, do Region=>Centroid  

then Region=>Get Information  

 

Dark subtracting 
First take a dark image of the same exposure with xmccd by selecting Dark from the Type menu, then 

click the Expose button 

This image will be called dark_mmmmm.fits, where mmmmm is the image serial number. 

 

Now make a dark-subtracted image with the command line “imdark targetnnnnn.fits  

dark_mmmmm.fits  targetnnnnnd.fits”  where “target” is the target name, nnnnn refers to the image 

serial number.  Notice the “d” after the second nnnnn, denoting the dark-subtracted image. 

 

More sophisticated dark subtraction, using a median combined series of dark images, can be performed 

from within AstroImageJ.  See “Introduction to …. AstroImageJ” section. 

 

Bias frames (zero exposure time) can be taken by selecting Bias from xmccd’s Type menu. 

 

Focussing 
The switch of the focusser control box must be on to Comp (for computer), and the 

Focusser/FinderScope turned on at the Ethernet Power Controller. 

 

An exposure time of ~1s is convenient.  Don’t select a bright star for focussing as it may saturate 

quickly as focus is approached.  Select Guiding on xmtel so that the star does not drift excessively. 

 

Draw a circular region centred on the selected star, of large enough size so that the star won’t drift 

outside (radius of ~200 suggested), and select it by clicking within.  By clicking the Region button on 

xmccd, only the region will be downloaded, reducing download time greatly.  To later restore xmccd to 

full download, deselect the region and click the Region button again. (Alternatively in xmccd Set-

>ImageRegion->Off) 

 

The plotfocus.py program can be run to automatically Gaussian fit to a star and add its FWHM, peak 

amplitude (above background) and focus position to three plots.  Help can be obtained with 

“plotfocus.py ?”.  A single circle region is required round the selected star, large enough so the star 

won’t drift outside. 

 

Alternatively FWHM and amplitude can be judged from the ds9 horizontal graph.  Remember to work 

with linear scaling to correctly judge the half-maximum. The max of the horizontal graph is set by the 

high value set on the Scale=>Scaling Parameters window. 

 

Now take a few images to get an idea of seeing variation. 

 

The getfocus program displays the current position of the focusser in encoder counts.  The command 

“setfocus x” will change the focus by ~x pixels in FWHM. 

 

Scripted Guiding 
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These scripts facilitate taking a series of images over a number of hours while keeping a star on more 

or less the same pixels (required for millimagnitude photometry), and also adjusting the dome.  It is 

really tuned for 100s images.   

 

Certain background scripts must be running, which are started by the startup scripts.   

 

Follow these steps: 

1. Ensure the focus is at the desired setting, and the image is centered. 

2. In ds9, pull down the File menu, select Preserve During Load, and tick all 3 items. 

3. In ds9, pull down the Region menu, select Region Parameters then Centroid Parameters, and 

set Iterations to 30 and Radius to its max of 50. 

4. In ds9, pull down the Region menu, select Region Parameters and tick Show. 

5. In ds9, pull down the Region menu, select Shape and select Circle. 

6. Orient the image with the usual convention left-E up-N 

For the telescope: 

 pointing E, pull down the Zoom menu and select InvertY.  (All other transforms off). 

 pointing W, pull down the Zoom menu and select InvertX.  (All other transforms off). 

7. In xmccd, pull down the Mode menu and select Single  (for single image). 

8. In xmccd, pull down the Set menu and set the Exposure to 100s. 

9. Ensure that other xmccd settings are correct (Filter,Fits etc). 

10. Ensure in xmtel that Guiding is turned on. 

11. Take an image.  Ensure that you are happy with the positioning etc. 

12. Depending on whether the telescope is looking east or west, run “look_east.sh” or 

“look_west.sh”. 

13. In ds9, select a star to guide on (intermediate in brightness), zoom in, click on its centre and 

drag a circle region out.  Select this region by clicking within it. 

14. Set the color to red (Region=>Color=>Red) and radius to 50 (Region=>Get 

Information=>Radius) 

15. Duplicate this region on top of itself by Ctl-c then Ctl-v. Move the cursor on top of the 

selected region (cursor changes to 4 arrows) then drag it aside.  Change its colour to green, 

then move it back onto the red circle, leaving it (the green one) selected. (This region has to be 

big enough for the star to stay within it between two exposures (it get recentered) but small 

enough not to include other comparable stars) 

16. In xmccd, pull down the Processing menu and tick Scripting (This will enable the scripted 

guiding once an exposure is taken) 

17. When ready to begin exposures, click xmccd’s Expose button 

 

An image is taken, and the star is located within the green circle, which is then centred on the star.  The 

scripts then nudge the mount to try to position the star in the next image taken in the centre of the red 

circle.  The dome position is adjusted, then another image is taken. 

 

The process can/should be watched in the message pane of the IndiPanel (of xephem’s Skyview 

window: from Skyview Telescope=>IndiPanel). 

 

The process can be stopped (losing the current image if being taken) by pressing xmccd’s Interrupt 

button, or after the next image by pulling down xmccd’s Processing menu and unticking Scripting. 

 

Note that currently dome tracking will fail if the telescope crosses the meridian, and the mount stops 

tracking near the horizon or ~10 degrees after crossing the meridian. 

 

Introduction to Live Aperture Photometry with AstroImageJ 
???????? 

 

Changing the filterwheel 
Have a clean plastic bag on hand to take the current filterwheel, and a blower to dust off the filters of 

the new wheel before installation.  Also, transport the new filterwheel in its plastic bag. 

 

1. It may help to orient the mount so there is easy access to the filterwheel housing. 

2. Rotate the pull knob on the back (camera side) of the filterwheel housing counterclockwise 

until the filterwheel is free in its hub. 
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3. Undo the knurled knob on the side of the housing and carefully lower the side door, being 

ready to hold the filterwheel on its body, not on the filters.   

4. Carefully slide the filterwheel out and place it in the plastic bag. 

5. Remove the new filterwheel from its bag and dust the filters both sides with the blower, again 

being careful not to touch the filters. 

6. Face the writing on the filterwheel towards the telescope, and slide it in to the housing, 

holding it in place. 

7. Close the side door and do up its knurled knob. 

8. Carefully rotate the pull knob (on back) clockwise and feel the filterwheel being located on its 

hub.  Only do up light finger tight. 

9. Power up the filterwheel via the Ethernet Power Controller and the switch on the hand 

controller (mounted on the sloping side of the plinth).  Press the home button on the controller 

and confirm in its display that the home is successful and the first filter position is reached. 

10. Carefully store the old filter (labelled) in the control room of the EDG building. 

 

Finishing up 
1. Allow two minutes for the background process to copy any new files from crux to mtkent1. 

2. Drive the dome so the dome azimuth is ~0, as given by the domeshow.sh command.  This 

ensures the solar panel charging the shutter battery gets full sun.  Alignment marks can be 

checked with the dome camera zoomed in and pointing just to the right of the dome. 

3.  Drive the mount to the home position.  Use the dome camera to see the marks on the white 

tape on each axis, and use xmtel’s NSEW buttons with Slew selected. 

4. Give the command “observatory_stop.sh”.  This turns off dome power and closes the shutters.  

Once this has finished, check that the shutters are fully closed with the dome camera. 

5. Give the command “session_stop.sh”, and wait till finished.  This powers down all else, exits 

the various programs, and renames the tonight directories to YYYYMMDD.  You may have 

to rename the tonight directory on mtkent1:/data1/cdk20s to YYYYMMDD 

6. Save and close any log file, and exit the various xterm windows, and log out. 

7. If at the observatory and it is required, engage the two dome lockdown turnbuckles, and the 

two shutter latches, and return the mirror covers to the telescope. 

8. Very important!!!  Double check that the shutters are closed, the dome is parked, and the 

dome door locked. 

 

Downloading data over the net is a slow process – if on site you may want to copy the night’s data to a 

portable drive.  The images are ~64MByte each. 

 

Troubleshooting 
Xephem 

On SkyView->Telescope->Configure 

 Check: Enable sending RA/Dec go  with  tel.target_2000.ra 

tel.target_2000.dec 

 Check: Enable Sky marker from  with  tel.telescope_2000.ra                   

tel.telescope_2000.dec 

        

Coords given for object are J2000 (if Equinox set to 2000 in xephem main window (under Local 

heading)) 

 

Is crux time correct? 
Make sure crux's time is correct.   Can run /usr/sbin/ntpq -p to check the ntp daemon. 

To restart the daemon, as root type 

cd /etc/rc.d 

./ntp restart 

 

Dome 
dome_monitor.py  reads tags and writes  

      ID      => /usr/local/observatory/status/dometag 

      azimuth =>                  "           /domeazimuth 

dome_show.sh     reads domeazimuth file and displays it 

tel_show.sh        ditto for telescope (RA & Dec) 
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dome_track.py    Reads tel coords and dome azimuth, works out which way to move, and moves dome 

to right place (once) 

 

Behind autosending to mtkent1 (set up by the startup scripts) 

On crux in /home/observer/data 

1. Make directory YYYYMMDD for tonight's data 

2. Make a symbolic link to "tonight's" dir ie 20120917, by “ln -s 20120917 tonight”.  (20120917 

can now be referred to as tonight) 

3. Run “crontab –e”.  This will start editing observer's crontab file (using vi by default, can 

change with EDITOR environment variable) 

4. Insert the following two lines (or remove '#' from start of second line if already there) 

# Update tonights images every 2 minutes 

0-59/2 * * * * /home/observer/bin/update_tonight.sh 

5. Exit (For vi, Esc to leave edit, then ZZ to exit).  This will now run “update_tonight.sh” every 

2 minutes, storing (for example) the 20120917 directory’s contents in /data1/cdk20s/tonight 

on mtkent1 

 

At end of night:  

1. Stop the cron job by inserting a '#' char before the 0-59 in the crontab file, by running “crontab 

–e” as before (i when in vi gets you into edit mode, Esc to exit edit mode, ZZ to exit) 

2. Run “rm tonight”      on crux in ~/data directory to remove the symbolic link  

3. Rename tonight on mtkent1 to the nights directory eg “mv tonight 20120917”  (in 

/data1/cdk20s 

 

update_tonight.sh (the crontab job) contains (all one line) 

rsync --progress -L -ave ssh /home/observer/data/tonight 

observer@mtkent1.mko.usq.edu.au:/data1/cdk20s/ 

 

Focusser 

The last position is stored in (owned by observer) 

/user/local/observatory/status/telfocus     a text file 

getfocus        reads this file 

 

Startup & Shutdown 

session_start.sh 

  Kills any running observatory programs 

  cd to /home/observer/data 

  Creates yyyymmdd directory 

  Removes tonight 

  Soft links tonight to yyyymmdd directory 

  Copies all /home/observer/data/queues files to tonight 

  Removes any observer crontabs 

  Starts the crontab to update mtkent1 with the files in tonight (every 2 minutes) 

  Powers up needed hardware (commented out for now) 

  Start indiserver 

  Start ccd_monitor.sh      Handles autoguiding if enabled 

  Starts xmtel, xephem, xmccd 

  Sets some INDI parameters 

  Sets ds9 preferences 

   

session_restart.sh 

  Restarts user programs (assumed killed) but not indiserver   

   

session_stop.sh 

  Reverse of above 

   

observatory_start.sh 

  powers up observatory stuff (not camera) and opens dome shutter 

observatory_stop.sh 

  Reverses above       

mailto:observer@mtkent1.mko.usq.edu.au:/data1/cdk20s/
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